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1PRIME (Ver. 2.2)-VII (Answer Key)

	Number System

Warm
Up! 	 a.	 98	 b.	 1188	 c.	 731

Rapid Fire

1.	 a.	 (ii)	 b.	 (ii)	 c.	 (ii)	 d.	 (i)
2.	 a.	 T	 b.	 T	 c.	 T	 d.	 T	 e.	 F

Evaluation Time

1.	 a.	 0	 b.	 2	 c.	 Decimal number 
	 d.	 1	 e.	 8	 f.	 Binary 
2.	 a.	 The octal number system is used as a shorthand representation of long binary numbers.
	 b.	 4 bits make 1 nibble.
	 c.	 Base of a number system represents the total number of digits in a number system. 
3.	 a.	� A Number System is simply a method of counting. There are many number systems in 

existence. The digital computer represents all kinds of data and information like audio, 
graphics, video, text and numbers in binary form. The total number of digits used in a number 
system is called its base or radix.

	 b.	 To convert a decimal number into a binary number, follow these steps:
	 	 Step 1:	 Divide the decimal number by 2 (the base of the binary number system).
	 	 Step 2:	 Note down the quotient and the remainder.
	 	 Step 3:	� Divide the quotient obtained again by 2 and note down the resulting quotient and 

remainder.
	 	 Step 4:	 Repeat the procedure till you reach a quotient less than 2.
	 	 Step 5:	� List the last quotient and all the remainders (moving from bottom to top). You will 

get your binary number.

1.
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	 c.	� In binary subtraction, binary number of lower value is subtracted from the binary number 
of higher value. The following table explains the subtraction of digit Y from digit X. If Y is 
greater than X, then 1 is borrowed from the next position. When the binary digit 0 borrows 
1 from the next most significant digit, it becomes 10.

		  The rules for binary subtraction:

		

X Y X + Y
0 0 0 – 0 = 0
0 1 0 – 1 = 1

(borrow 1, so that 
10 – 1 = 1)

1 0 1 – 0 = 1
1 1 1 – 1 = 0

		  For example, let us subtract the binary number (111)2 from (1000)2.
4.	 a.	 11001
	 b.	 (i)  1101	 (ii)	 10000	 (iii)	 1110	 (iv)	 11110	 (v)	 101110
5.	 a.	 1 × 25 + 0 × 24 + 1 × 23 + 1 × 22 + 0 × 21 + 1 × 20

	 	 = 32 + 0 + 8 + 4 + 0 + 1
	 	 = 45
	 	 Rahul actually earned 45 points in decimal.
	 b.	 1 × 25 + 0 × 24 + 1 × 23 + 1 × 22 + 0 × 21 + 1 × 20

	 	 = 32 + 0 + 8 + 4 + 0 + 1
	 	 = 45
	 	 Since both numbers are 45, they are equal.
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Group Task

Do it yourself.

In The Lab

Do it yourself.

	Advance Features of Excel

Warm
Up! 	 1.	 True	 2.	 True	 3.	 False	 4.	 False

			   5.	 False	 6.	 True	 7.	 False

Rapid Fire

1.	 a.	 (i)	 b.	 (i)	 c.	 (ii)	 d.	 (ii)	 e.	 (ii)
2.	 a.	 F	 b.	 F	 c.	 F	 d.	 T	 e.	 F

Evaluation Time

1.	 a.	 Column			   b.	 Custom sort			   c.	 Styles	
	 d.	 Conditional Formatting	 e.	 Filters
2.	 a.	� Pie Chart is a circular chart divided into sectors where each sector shows the relative size of 

each value. It always shows only one data series. 
	 b.	 Sorting data means to organise the data in ascending or descending order.
	 c.	 To remove filters, click on the filter command in the Data tab. 
	 d.	 Filter command is used to hide unimportant data.
3.	 a.	 Two types of charts provided by Excel are: 
		�  Pie Chart: It is a circular chart divided into sectors where each sector shows the relative size 

of each value. It always shows only one data series. It is useful when you want to emphasis 
on a significant element. 

		�  Bar Chart: The bar chart displays the data in the form of long rectangular rods also called 
bars. These bars can be placed horizontally on the chart area. It illustrates the comparisons 
amongst the individual items. 

	 b.	� Sorting data refers to the process of organizing data in ascending or descending order. 
Whereas, Filtering data refers to removing or hiding unimportant data to emphasis on the 
important information. 

2.
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	 c.	 Conditional formatting can be applied to the following criteria:
	 	 i.  Highlight Cells Rules	 ii.	 Top/Bottom Rules		 iii.	 Data bars
	 	 iv.  Color Scales 			   v.	 Icon sets
	 d.	 To apply custom sort feature, follow the given steps:
	 	 Step 1:	 Select the range of columns to be sorted.
	 	 Step 2:	 Click on the Sort & Filter command from the Editing group under Home tab.
	 	 Step 3:	 Click on the Custom Sort option.
	 	 Step 4:	� Check My data has headers checkbox, if the selected columns have a heading at 

the top.
	 	 Step 5:	� Click on the Sort by box and select the column header according to which you want 

to sort the data.
	 	 Step 6:	 Click on the Sort On box and select Cell Values option.
	 	 Step 7:	 Click on the Order box and select the A to Z or Z to A option. 
	 	 Step 8:	� Click on the Add Level button at the top of the Sort dialog box to add another 

column to sort.
	 	 Step 9:	 Click on the OK button.
4.	 a.	 Pie Chart
	 b.	� John should use the Sort feature in Excel, specifically Sort A to Z, to arrange the students 

names in ascending order quickly.
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(Based on chapters 1 & 2)
Periodic Assessment 1

A.	 1.	 The total number of digits used in a number system is called its base.
	 2.	 Hexadecimal number system consists of 16 digits from 0-9, A-F.
	 3.	 Conditional Formatting command is present under Home tab.
B.	 1.	 It is usually used to display the data in the form of vertical bars.
	 2.	� It is a circular chart divided into sectors where each sector shows the relative size of each 

value.
	 3.	 It is used to display the quantitative magnitude of the data graphically.
	 4.	 The bar chart displays the data in the form of long rectangular rods, also called bars.
	 5.	 They show correlations between two sets of values.
C.	 1.	 Scientific	 2.	 H
D.	 1.	 b	 2.	 c	 3.	 a

	Building on Animate CC

Warm
Up! 	 1.	 3	 2.	 frames	 3.	 frames per second

			   4.	 symbol

Rapid Fire

1.	 a.	 (iii)	 b.	 (iii)	 c.	 (iii)	 d.	 (iii)	 e.	 (ii)
2.	 a.	 T	 b.	 T	 c.	 F	 d.	 F

Evaluation Time

1.	 a.	 Masking	 b.	 Layers	 c.	 Properties	 d.	 Break Apart
2.	 a.	� The movement of an object in-between the frames is called Tween.
	 b.	 The various bytes of Tween in Animate CC are: 
	 	 i.  Motion Tween		  ii.	 Shape Tween			   iii.	 Classic Tween
	 c.	� Classic Tween is used for transition purpose. Whereas, Motion Tween is used to create 

movement and size.

3.
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3.	 a.	� Layers are sheets on which you place your drawings, animations and objects. They allow 
you to keep the elements of the animation separate. These are similar to transparent sheets, 
stacked one on top of the other.

	 b.	 Perform the following steps to format text in Animate:
	 	 Step 1:	 Click on the Text Tool from the Tools panel. 

	 	 Step 2:	 Under the Properties panel, choose the font size, color, style, etc.

	 	 Step 3:	 Type the text “ANIMATE” on the stage.

	 	 We can individually split the text with the Break Apart option. 

	 	 Step 4:	 Select the text with Selection Tool. 

	 	 Step 5:	 Click on the Modify → Break Apart option from the menu bar.

	 	 Step 6:	 Select the individual character and change the color.

4.	 a.	� Preeti should use the Break Apart option from the Modify menu to split the word into 
individual letters. 

	 b.	 Neeraj should use a Shape Tween to animate the transformation of a triangle into a square.
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	HTML—Lists and Tables

Warm
Up! 	 1.	 T	 2.	 F	 3.	 F	 4.	 F

			   5.	 T

Rapid Fire

1.	 a.	 (iii)	 b.	 (i)	 c.	 (iii)	 d.	 (iv)	 e.	 (i)

Evaluation Time

1.	 a.	 ordered list	 b.	 list item	 c.	 <UL>	 d.	 disc	 e.	 <CAPTION>
2.	 a.	 A list is a collection of related items.
	 b.	 Table represents data in the form of rows and columns.
	 c.	 A description list is a type of list that defines terms and provides their descriptions.
3.	 a.	� An ordered list is also called the numbered list. This type of list is used to display the items 

in a sequential manner. In HTML, the <OL> tag is used to create an ordered list. The <LI> 
tag is used to define an item in the list.

	 	� An unordered list is also called bulleted list. This type of list is generally used to display 
random items which never require to place in a sequential manner. The <UL>tag is used to 
define an unordered list. The <UL> tag has only TYPE attribute which describe the type of 
bullet style will appear with list items.

	 b.	 The properties of CSS list are: 
	 	 • � The list-style-type property specifies the type of list item marker. It can have the following 

values: for ordered lists, decimal, lower-alpha, upper-alpha, lower-roman, and upper-
roman; for unordered lists, disc, circle, and square.

	 	 • � The list-style-color property specifies the color of the list item marker. It can have a color 
name.

	 	 • � The list-style-image property specifies an image to be used as the list item marker instead 
of the default marker. It can have the URL of the image.

	 c.	� The ROWSPAN attribute applies when a single cell is extended for more than a single row, 
that is, the cell spans for 2 or more rows instead.

	 	� The COLSPAN attribute applies when a single cell is extended to more than a single column, 
that is, the cell spans for 2 or more columns.

4.	 a.	 Gurpreet can use the <OL> tag to create an ordered list of steps involved in baking a cake. 
	 b.	 Himesh can use the <TABLE> tag to display the marks obtained in different subjects.

4.
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Activity Time
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In The Lab

Do it yourself.

	Algorithmic Intelligence

Warm
Up! 	 Do it yourself.

Rapid Fire

1.	 a.	 (iii)	 b.	 (i)	 c.	 (ii)
2.	 a.	 F	 b.	 F	 c.	 T	 d.	 F	 e.	 T

Evaluation Time

1.	 a.	 An algorithm is a set of step-by-step instructions in a sequential manner to solve a problem. 
	 b.	 Information processing involves acquiring, storing, analysing, retrieving, and displaying data. 
	 c.	 The binary code for the ASCII uppercase letter ‘A’ is 1000001.

5.
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2.	 a.	� Algorithmic intelligence is when computers use rules and data to make decisions, solve 
problems, or learn from patterns.

	 b.	 IF day = “Sunday”
	 	     PRINT “picnic”
	 	 ELSE
	 	     PRINT “School”
	 c.	 Computers use binary code, composed of 1s and 0s, to store and process information.
	 d.	� The IF-THEN-ELSE condition is used to check conditions in a program. The program executes 

the statements written inside the IF block when the condition is true. If the condition is false, 
the statements written inside the ELSE block will be executed.

3.	 a.	� Eklavya right brain is likely more active since he is excels in creative writing and loves drawing 
and painting.

	 b.	 Simran should use 01000010 for ‘B’ and 00000011 for 3.

Activity Time
1.	 4 4 4 4 4 4 4 4 4 4 4 4 4 4 4 4 4 4 4

4 4
4 2 2 3 3 1 1 4
4 2 2 3 3 1 1 4
4 2 2 1 1 3 3 4
4 2 2 1 1 3 3 4
4 2 2 1 1 4

4 2 2 1 1 3 3 4

4 3 3 4
4 4
4 4 4 4 4 4 4 4 4 4 4 4 4 4 4 4 4 4 4

2.	 READ num 
	 IF num % 3 = 0 THEN
	     PRINT “num is divisible by 3”
	 ELSE
	     PRINT “num is not divisible by 3”

In The Lab

Do it yourself.
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(Based on chapters 3 to 5)
Periodic Assessment 2

A.	 1.	 Start			   2.	 Input			   3.	 Output

	 	 	

B.	

Layers

Insert Layer Delete Layer

C.	 <!DOCTYPE html>
	 <HTML>
	 <HEAD>
	 <TITLE>Permanent Gases of the Atmosphere</TITLE>
	 <STYLE>
	 TABLE,TH,TD{
	 BORDER:2px;
	 BORDER-COLOR:#e0f0e0;
	 BORDER-STYLE:SOLID;
	 }
	 TH {
	 BACKGROUND-COLOR: #e0f0e0;
	 }
	 </STYLE>
	 </HEAD>
	 <BODY>
	 <TABLE>
	 <TH COLSPAN=”3”>Permanent Gases of the Atmosphere</TH>
	 <TR STYLE=”BACKGROUND-COLOR: #e0f0e0;”>
	 <TH>Constituent</TH>
	 <TH>Percent by Volume</TH>
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	 <TH>Concentration (ppm)</TH>
	 </TR>
	 <TR>
	 <TD>Nitrogen</TD>
	 <TD>78.084</TD>
	 <TD>780,840.00</TD>
	 </TR>
	 <TR>
	 <TD>Oxygen</TD>
	 <TD>20.986</TD>
	 <TD>209,460.00</TD>
	 </TR>
	 <TR>
	 <TD>Argon</TD>
	 <TD>0.934</TD>
	 <TD>9,340.00</TD>
	 </TR>
	 </TABLE>
	 </BODY>
	 </HTML>

D.	

(Based on chapters 1 to 5)

Test Sheet  1

A.	 1.	 (ii)	 2.	 (ii)	 3.	 (ii)	 4.	 (iii)	 5.	 (iii)	 6.	 (i)

B.	 1.	 T	 2.	 T	 3.	 F	 4.	 F	 5.	 F	 6.	 T

C.	 1.	 1	 2.	 8	 3.	 Column	 4.	 Mask	 5.	 Table Data

	 6.	 <CAPTION>



12 PRIME (Ver. 2.2)-VII (Answer Key)

D.	 1.	 4 bits make 1 nibble. 
	 2.	 Base of a number system represents the total number of digits in a number system. 
	 3.	 Sorting data means to organise the data in ascending or descending order. 
	 4.	 The various bytes of Tween in Animate CC are: 
	 	 i.  Motion Tween          ii.  Shape Tween          iii.  Classic Tween 
	 5.	 A description list is a type of list that defines terms and provides their descriptions.
	 6.	 Information processing involves acquiring, storing, analysing, retrieving, and displaying data. 
E.	 1.	 To convert a decimal number into a binary number, follow these steps: 
	 	 Step 1:	 Divide the decimal number by 2 (the base of the binary number system). 
	 	 Step 2:	 Note down the quotient and the remainder. 
	 	 Step 3:	� Divide the quotient obtained again by 2 and note down the resulting quotient and 

remainder. 
	 	 Step 4:	 Repeat the procedure till you reach a quotient less than 2. 
	 	 Step 5:	� List the last quotient and all the remainders (moving from bottom to top). You will 

get your binary number. 
	 2.	 Two types of charts provided by Excel are: 
	 	� Pie Chart: It is a circular chart divided into sectors where each sector shows the relative size 

of each value. It always shows only one data series. It is useful when you want to emphasis 
on a significant element. 

	 	� Bar Chart: The bar chart displays the data in the form of long rectangular rods also called 
bars. These bars can be placed horizontally on the chart area. It illustrates the comparisons 
amongst the individual items. 

	 3.	� Sorting data refers to the process of organizing data in ascending or descending order. 
Whereas, Filtering data refers to removing or hiding unimportant data to emphasis on the 
important information.

	 4.	� Layers are sheets on which you place your drawings, animations and objects. They allow 
you to keep the elements of the animation separate. These are similar to transparent sheets, 
stacked one on top of the other. 

	 5.	 The properties of CSS list are: 
	 	 • � The list-style-type property specifies the type of list item marker. It can have the following 

values: for ordered lists, decimal, lower-alpha, upper-alpha, lower-roman, and upper-
roman; for unordered lists, disc, circle, and square.

	 	 • � The list-style-color property specifies the color of the list item marker. It can have a color 
name.

	 	 • � The list-style-image property specifies an image to be used as the list item marker instead 
of the default marker. It can have the URL of the image.

	 6.	� Algorithmic intelligence is when computers use rules and data to make decisions, solve 
problems, or learn from patterns. 
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	More on Python

Warm
Up! 	 1.	 3400	 2.	 100%6	 3.	 100100100100100

Warm
Up! 	 1.	 F	 2.	 F	 3.	 F	 4.	 T

Warm
Up! 	 if(age > 18):

			       print(‘You are eligible to vote’)
			   else:
			       print(‘Not eligible to vote’)

Rapid Fire

1.	 a.	 (iii)	 b.	 (i)	 c.	 (iv)	 d.	 (ii)	 e.	 (iii)
2.	 a.	 F	 b.	 F	 c.	 T	 d.	 F

Evaluation Time

1.	 a.	 Multiple	 b.	 +	 c.	 *	 d.	 Unary	 e.	 Left
2.	 a.	 Operator precedence refers to the priority assigned to each operator in Python.
	 b.	� Logical operators are used to evaluate multiple comparisons and return a Boolean result of 

either True or False.
	 c.	 The syntax of The if…elif…else Statement is:
	 	 If (condition):
	 		  Indented block
	 	 elif (condition):
	 		  Indented block
	 	 else:
	 		  Indented block
3.	 a.	 There are three forms of conditional statements in Python: 
	 	 • � if Statement: a statement or a collection of statements within the if block is executed only 

if a certain condition or expression evaluates to True. Otherwise, the control of execution 
is passed to the next statement after the if block.

6.
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	 	 • � If else Statement: An if…else statement provides a set of two paths, one if the condition 
is True and the other if the condition is False.

	 	 • � If elif else Statement: If the condition in the if statement is true, its block runs, and the 
rest are skipped. If not, Python checks each elif condition until it finds one that is true. If 
not any condition true then else block is executed.

	 b.	 There are two types of Arithmetic Operators are:
	 	 • � Unary Operators: Unary operators require a single operand and are commonly used to 

change a value to its negative form or to indicate that it is positive. For example, A=-20.
	 	 • � Binary operators require two operands to operate. For example, in the expression a + b, 

the + operator adds the two operands a and b.
	 c.	� An if…else statement provides a set of two paths, one if the condition is True and the other 

if the condition is False. For example, 
		  age=int(input("Enter your age"))

		  If age>=18:

		     print("You are eligible to vote")

		  else: 

		     print("You are not eligible to vote")

4.	 a.	� Bhavya can use conditional statements to execute a particular set of statements depending 
on a test condition.

	 b.	 Aryan should use relational operators to create a relation chart between various data types.

Activity Time

	 a.	 20
	 b.	 6
	 c.	 100
	 d.	 Positive number

In The Lab

Do it yourself.

	Computer Virus

Warm
Up! 	 1.	 a	 2.	 c	 3.	 d	 4.	 b

7.
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Rapid Fire

1.	 a.	 (ii)	 b.	 (iii)	 c.	 (i)	 d.	 (iii)	 e.	 (iii)
2.	 a.	 F	 b.	 F	 c.	 F	 d.	 T

Evaluation Time

1.	 a.	 Malware	 b.	 Antivirus	 c.	 Firewall	 d.	 Trojan Horse
2.	 a.	� A computer virus is a piece of code or program developed to corrupt the data or program 

files stored in the computer system.
	 b.	 Rootkit is a malware that gains administrator access to the host system.
3.	 a.	 Three harms caused by a computer virus are:
	 	 •  They can crash your hard disk. 
	 	 •  They can destroy all or some of your data. 
	 	 •  They decrease the processing speed of the computer.
	 b.	 Four common symptoms of an infected computer system are:
	 	 •  Displaying unusual messages on the screen.
	 	 •  Loading programs slowly.
	 	 •  Taking more time to shut down Windows.
	 	 •  Increasing the size of infected files.
4.	 a.	 The possible cause of Suhana’s computer issues could be a malware or virus infection.
	 b.	� The type of virus that might have caused harm to Swati’s computer is an Email Virus or Trojan 

Horse.
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Find Out

Do it yourself.

In The Lab

Do it yourself.

(Based on chapters 6 & 7)
Periodic Assessment 3

A.	 1.	� A computer virus is a piece of code or program developed to corrupt the data or program 
files stored on the computer system. 

	 2.	 A set of programs that identify and remove malware is known as antivirus software. 
	 3.	� Relational operators are used to compare the values of the operands and return the result 

as true or false.
B.	 num = int(input(“Enter a number: “))
	 i = 2
	 isPrime = True
	 if num > 1:
	     while i <= num / 2:
	         if num % i == 0:
	             isPrime = False
	             break
	         i += 1
	 if isPrime:
	     print(num, “is a prime number.”)
	 else:
	     print(num, “is not a prime number.”)

	Cyber Safety

Rapid Fire

1.	 a.	 (ii)	 b.	 (iii)	 c.	 (iii)	 d.	 (i)
2.	 a.	 T	 b.	 F	 c.	 F	 d.	 T	 e.	 F

8.
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Evaluation Time

1.	 a.	 network	 b.	 Spamming	 c.	 Ethical Hacking
	 d.	 transaction	 e.	 patent
2.	 a.	� Hacking is the activity of identifying weaknesses in a computer system or a network to exploit 

the security to gain access to personal data.
	 b.	 Two examples of intellectual property rights are: Copyrights and Patents.
	 c.	� Try avoiding friend requests from unknown people on social media. If your parents/elders 

feel the need, they can also contact the local police station to lodge a complaint against the 
cyber bully.

3.	 a.	� When someone sends e-mails that appear genuine from a trusted e-mail ID but in reality 
they’re not to be trusted. 

	 �For example, a user may receive an e-mail from a portal or social media platform where spelling 
of service provider or email ID has been slightly changed.

	 b.	 Some effective ways to prevent cyberbullying are:
	 	 • � Remember never to share personal details such as age, address, date of birth, etc. with 

unknown people on social media. 
	 	 • � Restrict the access to your personal data on social media platforms. For example, only 

your friends must be able to see any pictures on Facebook. 
	 	 • � Try avoiding friend requests from unknown people on social media. 
	 c.	 Types of Online Transaction Frauds are:
	 	 1.	� Identify Theft: Sometimes, cybercriminals deliberately use someone else’s identity to gain 

a financial advantage over someone else. Cybercriminals may also pose as someone else 
to obtain credit and other benefits in the other person’s name. 

	 	 2.	 Job Frauds: Cybercriminals portray incorrect details as an employer. 
	 	 3.	� Banking Frauds: Some cybercriminals fraudulently obtain money from users for investment 

by posing as a bank or other financial institution. 
	 d.	 Internet is also called as “the NET” or Network of Networks, means International Network. 
	 	 Disadvantages of Internet are:
	 	 1.	 Pornographic and Violent Pictures
	 	 2.	 Wastage of Time
	 	 3.	 Virus and Spam Attacks
4.	 a.	� Anju can check the sender’s email ID. If she doesn’t know the sender, or if the email contains 

messages like “You have won prize money or expensive gifts” or “You are a lucky winner of 
a trip abroad”, then it could be spam.

	 b.	� Rajiv can check if the website URL starts with HTTPS. A website URL with HTTPS encrypts 
your data on the website and protects it from any kind of tampering.
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Activity Time
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In The Lab

Do it yourself.

	Internet Services

Rapid Fire

1.	 a.	 (i)	 b.	 (i)	 c.	 (iv)	 d.	 (iv)	 e.	 (i)
2.	 a.	 T	 b.	 F	 c.	 T	 d.	 T	 e.	 F

Evaluation Time

1.	 a.	 cash on delivery			   b.	 communicate, information
	 c.	 Facebook			   d.	 blogger			   e.	 question
2.	 a.	 Facebook, Twitter and Instagram.
	 b.	 Two modes of payments are Net Banking and E-wallet.
	 c.	 You are not allowed to post political content and poorly phrased questions.
	 d.	 (i)	 Your sensitive data might be at risk from hackers.
	 	 (ii)	 Some people might face issues like data loss.

9.
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3.	 a.	� Blog is a short form of WEBLOG, which refers to a website where new information about any 
topic is updated regularly. The latest posts appear first. The term Weblog was coined by an 
American blogger named Jorn Barger in 1997. It is like a journal where you write about your 
life and thoughts.

	 b.	 The key features of Skype are as follows:
		  • � Skype translates the conversation in real-time if the person is talking in a different 

language.
		  •  It is a safe way to have conversation with people without any interruption.

		  •  You can share your screen to train someone.
	 	 •  It has Live Subtitles option. This helps a hearing-impaired person to keep up with the call. 
	 c.	� Website is a collection of static pages such as home page, contact page, profile page. On the 

other hand, blog contains both pages and posts but mostly posts. Websites usually don’t 
change regularly as blogs do.

4.	 a.	� Shreya can use any cloud computing service, such as Google Drive, Dropbox, or OneDrive, 
to share files and complete her project on time without wasting time traveling.

	 b.	� Rihan can use social media platforms like Facebook, Instagram, or LinkedIn to reach out to 
his old friends.
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In The Lab

Do it yourself.
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	Concept of Smart Living

Warm
Up! 	 a.	 P

Warm
Up! 	 1.	 (ii)	 2.	 (ii)

		  	 3.	 (ii)

Rapid Fire

	 a.	 (ii)	 b.	 (iv)	 c.	 (iv)	 d.	 (i)

Evaluation Time

1.	 a.	 Video Doorbells			   b.	 Smart Cameras
	 c.	 Smart Home			   d.	 Smart TV
2.	 a.	� Smart Homes are homes that use internet connected devices to empower remote monitoring 

and management of appliances and devices.
	 b.	� Smart lights help in saving and conserving energy. It can be programmed to turn on or off, 

control the brightness, and store your preferences.
3.	 a.	� Smart speakers can accept voice commands and can be controlled through smart phones. 

They can also perform activities like creating a playlist, turning on reminders, searching for 
information on the Internet, etc.

	 b.	� One benefit of Smart Homes is that they are great at saving power. For example, people 
often forget to switch off their lights when they go to sleep. Smart Homes can detect when 
the user is asleep and automatically switch off the lights.

4.	 a.	� I would suggest Neha to buy a Smart Camera or a Smart Security System that can monitor 
indoor and outdoor activities.

	 b.	� Nihar is living in a Smart Home, which is equipped with smart security devices to protect the 
home and its belongings.

	 c.	� Riyan is talking about a Smart Lighting System, which can be programmed to turn on/off, 
control brightness, and store his preferences, helping him save energy.

Activity Time

Smart Speakers Smart Lights Smart Smoke Detectors Video Door

10.
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In The Lab

Do it yourself.

(Based on chapters 8 to 10)
Periodic Assessment 4

A.	 1.	 A digital footprint refers to the data trail left behind when a person uses the Internet.
	 2.	� Cyber safety refers to the safe and responsible use of the Internet in order to safeguard one’s 

personal information while not misusing anyone else’s personal information.
	 3.	� Smart Smoke Detectors devices sound an alarm when smoke is detected. It can warn you if 

there is fire in your home. 
B.	 1.	 Electronic Mail			   2.	 Intellectual Property Rights
	 3.	 Cash On Delivery			  4.	 Payment Service Provider
C.	 1.	 Google Cloud			   2.	 Paytm
	 3.	 HDFC NetBanking		  4.	 Facebook.com
	 5.	 Blogger.com

(Based on chapters 6 to 10)

Test Sheet  2

A.	 1.	 (iv)	 2.	 (ii)	 3.	 (iii)	 4.	 (iii)
	 5.	 (iv)	 6.	 (ii)
B.	 1.	 F	 2.	 T	 3.	 F	 4.	 F
	 5.	 T	 6.	 T
C.	 1.	 +	 2.	 Firewall	 3.	 Network	 4.	 Spamming
	 5.	 Cash on Delivery			  6.	 Smart Cameras
D.	 1.	 Operator precedence refers to the priority assigned to each operator in Python.
	 2.	� A computer virus is a piece of code or program developed to corrupt the data or program 

files stored in the computer system.
	 3.	� Hacking is the activity of identifying weaknesses in a computer system or a network to exploit 

the security to gain access to personal data. 
	 4.	 Two examples of intellectual property rights are: Copyrights and Patents.
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	 5.	 Two modes of payments are Net Banking and E-wallet.
	 6.	� Smart Homes are homes that use Internet connected devices to empower remote monitoring 

and management of appliances and devices.
E.	 1.	 There are three forms of conditional statements in Python: 
	 	� If Statement: a statement or a collection of statements within the if block is executed only 

if a certain condition or expression evaluates to True. Otherwise, the control of execution is 
passed to the next statement after the if block.

	 	� If else Statement: An if…else statement provides a set of two paths, one if the condition is 
True and the other if the condition is False.

	 	� If elif else Statement: If the condition in the if statement is true, its block runs, and the rest 
are skipped. If not, Python checks each elif condition until it finds one that is true. If not any 
condition true then else block is executed.

	 2.	 There are two types of Arithmetic Operators are:
	 	 • � Unary Operators: Unary operators require a single operand and are commonly used to 

change a value to its negative form or to indicate that it is positive. For example, A=-20.
	 	 • � Binary Operators: Binary operators require two operands to operate. For example, in the 

expression a + b, the + operator adds the two operands a and b.
	 3.	 Four common symptoms of an infected computer system are:
	 	 • � Displaying unusual messages on the screen.
	 	 • � Loading programs slowly.
	 	 • � Taking more time to shut down Windows.
	 	 • � Increasing the size of infected files.
	 4.	 Some effective ways to prevent cyberbullying are: 
	 	 • � Remember never to share personal details such as age, address, date of birth, etc. with 

unknown people on social media. 
	 	 • � Restrict the access to your personal data on social media platforms. For example, only 

your friends must be able to see any pictures on Facebook. 
	 	 • � Try avoiding friend requests from unknown people on social media. 
	 5.	 The key features of Skype are as follows: 
	 	 • � Skype translates the conversation in real-time if the person is talking in a different language. 
	 	 • � It is a safe way to have conversation with people without any interruption. 
	 	 • � You can share your screen to train someone. 
	 	 • � It has Live Subtitles option. This helps a hearing-impaired person to keep up with the call. 
	 6.	� One benefit of Smart Homes is that they are great at saving power. For example, people 

often forget to switch off their lights when they go to sleep. Smart Homes can detect when 
the user is asleep and automatically switch off the lights.


